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[bookmark: Formulas]Formulas 
VLOOKUP 
The VLOOKUP function searches vertically (top to bottom) the leftmost column of a table until a value that matches or exceeds the one you are looking up is found. 
The elements being looked up must be unique and must be arranged or sorted in ascending order; that is, alphabetical order for text entries, and lowest-to-highest order for numeric entries. 
The syntax is =VLOOKUP(lookup_value,table_array,col_index_num,[range_lookup]). 
An example of the formula is: VLOOKUP(E2,D2:M3,2,TRUE) The English translation is using the value found in the cell E2, look in the range of D2 to M3 row by row. If you find a value that matches or exceeds the value in E2, using that row, go over 2 columns to the right, grab the value there and bring it back. 
There are two range_lookup argument options; TRUE or FALSE 
TRUE 
Is the default answer, so you may leave it out of the formula 
Looks for an approximate match 
If it finds an exact match it will use it. 
If it doesn’t find an exact match, it will use the last item before it got greater 
Alphabetical: Looking for Cat. If elements are Apple, Bird, Carpet, Dog; then Carpet would be returned because Dog exceeds Cat alphabetically. 
Numeric: Looking for 5.25. If elements are 3.0, 4.0, 5.0, 6.0, 7.0, then 5.0 would be used. The last number before 5.25 was exceeded. 
FALSE 
Looks for an exact match. 
If it finds an exact match it will use it.
If it doesn’t find an exact match, it will return #N/A 
Alphabetical: Looking for Cat. If elements are Apple, Bird, Carpet, Dog; then #N/A would be returned. 
Numeric: Looking for 5.25. If elements are 3.0, 4.0, 5.0, 6.0, 7.0, then #N/A would be returned because there is no exact match. 
[bookmark: COUNTIFS]COUNTIFS 
Recall quickly the COUNT and IF commands. 
COUNT 
The COUNT function counts the number of cells that contain numbers and counts numbers within the list of arguments. 
The syntax is COUNT( value1, value2, …) 
Continuing on with our SUM formula from above, let’s not only add up the values of the range A1:A4, but let’s count how many numbers are included within the range, i.e. how many cells within the range has a value in it. 
The formula is =COUNT(A1:A4). The English translation is count how many cells within the range has a value in it and display the result. 
[image: index-4_1.png]

Notice that the range is exactly the same as our 
[image: index-4_2.png]
SUM, A1:A4, which includes four rows. The value 
returned in cell A7 is three, because only three of 
the four rows have values in them. 
[bookmark: If_you_are_trying_to_count_text]If you are trying to count text, use the COUNTA formula which counts the non-blank cells. 
IF 
The formula makes a statement/question, if the answer is true then one response is obtained. If the answer if false, then another answer is obtained. 
The syntax is =IF(logical_test,value_if_true,value_if_false) 
Continuing on with our SUM formula from above, let’s add some verbage to emphasize whether the result is greater or less than twenty. 
The formula is =if(A5<20,”Amount is less than twenty”,”Amount is more than twenty”). The English translation is if the value found in A5 is less than twenty THEN display the comment ‘Amount is less than twenty’ ELSE display the comment ‘Amount is more than twenty’. 
[image: index-5_1.png]

COUNTIF 
The COUNT function counts the number of cells in a range, that meets single criteria. 
[image: index-5_2.png]
[bookmark: COUNTIFS_1]COUNTIFS 
The COUNT function counts the number of cells in a range that meets multiple criteria. 
[image: index-6_1.png]

 
[bookmark: Filters]Filters 
Ribbon Tour 

Quick Filtering 
The secret to filtering is not to have a space between your titles and your data. In fact, Excel is so smart, that you do not even have your data selected, but may if you prefer. 

Select your data and left click on 
[image: index-7_1.png]
the filter icon in the Sort & Filter 
[image: index-7_2.jpg]
Group. 

Notice that a chevron appears to 
the left of each header. 

[bookmark: page_8][image: index-8_1.png]
By selecting the chevron to the left of Vendor Name, a dialog 
box appears displaying all unique text filters found in the range 
as well as other common sort icons. 
If you only want a particular filter, deselect the (Select All) box 
and check the filter you desire. 

In the below screen shot, Kendell Kilborn is selected. Notice the hidden rows to the left. Those represent data lines for mileage paid to individuals other than Kendell. No data is lost, it is just currently hidden. 

Also note that the icon to the left of 
the vendor name now displays the filter icon. 
This so at a glance the user may see that the 
data range has been filtered. 
[image: index-8_2.png]
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[bookmark: Filtering_by_Multiple_Criteria]Filtering by Multiple Criteria 
The filtering tool is fine when you only want one item. However the power of the advance filter tool really shines when you want to sort by multiple criteria. There are several thou shalts of advanced filtering. 
Thou Shalts of Advanced Filtering 
1  The headers in the criteria range must be exactly as they are in the list range 
2  l There must be at least one blank row between the criteria range and the list range 

Steps For Advanced Filtering 
Create a criteria range by inserting a few rows and copying the header from the data range. 
1 Although not required, it is often best to have the range above your data for simplicity. 
2 Type in the criteria you want to filter by. 
Have your curser somewhere in the data range
3
[image: index-9_1.png]

4 Select the Advanced icon  with your left mouse button. 
The list range most likely will be your data. If not, you will need to correct it. 
5
Select your criteria range. 
6 • The range must include the headers of the criteria range 
• The rows with criteria 
• All columns in the range 
Select OK 
7

: 

[bookmark: page_10][image: index-10_1.png]
4

1 2
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5

The results appear below. 
[bookmark: page_11][image: index-11_1.png]
Saving the Filtered Data 

Now that the data has been filtered it would be great to save it so you can manipulate it further. To do so is a rather straight forward process. Basically you will go to where you want to save it, Sheet2 in our example, and go through the filtering process that we did above with just a couple of twists. 
Steps For Advanced Filtering 
On the destination worksheet (Sheet2 for example) place the cursor in a blank cell. 
1
[image: index-11_2.png]
2
Select the Advanced icon  with your left mouse button. 
3 Under Action, select copy to another location
[image: index-11_3.png]

• In the list range, select the range finder icon. 
[image: index-11_4.png]
The appears. Navigate to the appropriate 
[image: index-11_5.jpg]
4 worksheet and select the data range not forgeting the headers, and click on the 
little icon at the bottom right. 
• Do the same for the criteria range. • For the copy to range, select the first cell and select OK 
[bookmark: page_12][image: index-12_1.png]
4


Performing Calculations on Filtered Data 
Excel’s traditional formulas do not work on filtered data since the function will be performed on both the hidden and visible cells. To perform functions on filtered data one must use the subtotal function. 
The syntax is SUBTOTAL(function_num, range_reference1, range_reference2,….)The following functions may be performed with the subtotal. The function_num within the syntax relates to the numbered function. 
Function  Function Function  Function 
Number  Number 
1  AVERAGE  7  STDDEV 
2  COUNT  8  STDDEVP 
3  COUNTA  9  SUM 
4  MAX  10  VAR 
5  MIN  11  VARP 
6  PRODUCT 

[bookmark: page_13][image: index-13_1.png]
An example of the formula is: =SUBTOTAL(9,E12:F19) The English translation is using the ninth subtotal function, which is SUM, add up all of the data within the range that is selected by the filter. For comparison, included is the SUM function for the same range which brought back the total for all of the data cells, hidden or displayed. 

PivotTables 
Defined 
The foundation of what is a PivotTable report is explained as follows: 
As long as you can connect to the data, whether it be locally in the same workbook or remotely in other locations, you can built PivotTable reports that rearrange the raw data and change it into meaningful information 
A pivot table is an interactive way to quickly summarize large amounts of data; to analyze numerical data in detail and to answer unanticipated questions. They are especially designed for: 
• Querying large amounts of data in many user-friendly ways • Subtotaling and aggregating numeric data, summarizing data by categories and subcategories, 
and creating custom calculations and formulas 
• Expanding and collapsing levels of data to focus your results, and drilling down to details from 
the summary data. 
• Moving rows to columns or columns to rows (or “pivoting”0 to see different summaries of the 
source data. 
• Filtering, sorting, grouping, and conditionally formatting the most useful and interesting subset 
of data to enable you to focus on the information that you want. 
[bookmark: Thou_Shalts_in_PivotTable_Land]Thou Shalts in PivotTable Land 
1 Headers should be in columns, not rows 
2 No blank rows between the headers and the data 
Best to have the pivot table on a separate worksheet so it does not accidently clobber the 
3 
data 
4 Best to have simple data, rows and columns of data. 
5 Best to format your area as a table, especially when you will be adding data to it. The table 
is automatically expanded when data is added to the next row. Now when you launch create a pivot table the range will be the table name, and not the cell addresses 

Basic PivotTable Data 

Pivot Tables work best when you have simple data in rows and columns. 
• Headers are across the top in the first row • Data consists of a single row across numerous columns • There is not a blank row between the headers and the rows 
[image: index-14_1.jpg]

Inserting a Pivot Table 
[image: index-14_2.png]
• Select any active cell within your data 
table 
• Navigate to the Insert tab and select 
PivotTable
[bookmark: When_you_do_so__the_create_Pivot]When you do so, the create PivotTable 
dialog box appears. 
[image: index-15_1.png]
• Excel will guess the data range 
that you will want; correct it if it is 
wrong. 
• The default destination for the 
PivotTable will be a new 
worksheet. 
• When doing so, a new sheet will 
automatically be added to your 
workbook. 
• It is good to use a new worksheet 
for the pivot table so that your 
source data doesn’t accidently get 
clobbered. 
PivotTable Geography 
[image: index-15_2.png]
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[image: index-15_3.png]
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[bookmark: PivotTable_Geography]PivotTable Geography 

The pivot table will be located here. The size will adjust as it needs to automatically. 
1 • NOTE: If you move your mouse out of this area, the PivotTable Field List will disappear. To 
get it back, merely left click your mouse within this area again and it will appear. 
The fields listed here are your column headers on your original data source. 
2 • These fields may be utilized in designing your PivotTable Report. 
• You may use a field more than once. Report Filters: 
3 • Similar to a mentally page break. Allows the user to classify the data 
4 Column Labels: 
• Often created automatically by dragging data fields to the value zone. The user may also 
drag data fields to this zone for grouping, etc. 
Row Labels: 
5 • Most common label 
Values: 
6 • Wide range of calculations may be performed on the values dragged to this zone. 

Building a PivotTable Report – Part One 
Adding row labels, adding column data, changing formulas in columns, changing headers & number formats 
In order to best illustrate how to design pivot tables, we will begin with the goal report, depicted below, and then step through each design component. 
This table will represent by department, the number of employees per department and their average salary. We will also change a column header and the number font for the salary column. 

[bookmark: page_17][image: index-17_1.png]
Figure 1: Building a PivotTable- Part One 

[bookmark: page_18][image: index-18_1.png]
2

1

Create Row Label 
• Select the Dept name with your mouse, left click, and drag it to the row label
1 zone. 
2 • The list our SCOE departments now appear to the left. 

[bookmark: page_19][image: index-19_1.png]
2

1

2

1

Adding a COUNT and SUM Columns 
• Drag down last name and salary into the Value zone
1
• Last Name 
2 Every employee has a last name. So if we use last name in a value field the o
result displayed in the field will merely be the number of last names that we have. 
o Note that the formula used is count because it is a text field. 
• Salary 
o Excel automatically used the SUM formula. o The SUM formula needs to be changed to the AVERAGE formula 

To change the formula, we will launch the value fields setting dialog box and choose a different formula. 
[bookmark: page_20][image: index-20_1.png]
1

[image: index-20_2.png]

3
[image: index-20_3.png]

2

Changing a Formula 
1 Left click on the Sum of Salary field 
2 The value dialog box will appear. Using a left click on your mouse, select the Value Field Settings 
3 The value field settings dialog box appears. On the summarized by tab, select the average 
calculation from the drop down box The result is represented below. Notice that the header now is Average of Salary, rather than Sum 3
[bookmark: of_Salary]of Salary. 
[image: index-21_1.png]

3

Now we want to change the column headers and the number format. 

[bookmark: page_22][image: index-22_1.png]
1

2

Changing Column Headers and Number Formats 
1 Left click on the Count of Last Name column header, B4. Modify the title as you would any title 
in a normal spreadsheet, in other words, get typing. 
2 Select any cell in the Average of Salary column. Right click on your mouse which launches an 
option dialog box. Left click on value field settings option which launches the value field setting dialog box. 
3 In the value field settings dialog box, select the number format button on the bottom left 
corner. 
4 Within the format cells dialog box, select your desired format 

[bookmark: page_23][image: index-23_1.png]
• Place your mouse anywhere within the 
2 Average of Salary column data. 
• Right click your mouse which will display 
the option box. 
• Select the value field settings option. 
[image: index-23_2.png]

4
[image: index-23_3.png]

3

Figure 2: Value Field Settings Dialog Box 

We now have the final results below. 

[bookmark: page_24][image: index-24_1.png]
Building a PivotTable Report – Part Two 
Adding multiple row labels, collapsing and expanding, drill down to data, sorting, & refreshing 
We can expand the detail provided in the pivot table if we would like. Using the table grouped by departments if the last name is dragged to the row label zone then each department will have the last name of the employees listed. 

[bookmark: page_25][image: index-25_1.png]
The results can either be collapsed or expanded by either selecting the collapsed or expanded icon located on the PivotTable Tools\options tab and within the active fields group. Using the + or – icon located to the left of each row label will have the same result. 
[image: index-25_2.png]

If we want to obtain detail information on our items we can by double left clicking on any calculated field. For example, if we double click on cell B19, the number of employees in the WES Camp department, the following appears on a separate tab. 
[bookmark: page_26][image: index-26_1.png]
Two very useful icons on the PivotTable Tools tab are sort and refresh.

[image: index-26_2.jpg]

1 2

PivotTable Tools Option Tab 
1 Sort works exactly the same as the sort on the Data tab. However, if you want to sort the results 
created in the PivotTable, you must use the icon located on this tab. 
2 If you update your source data, it is imperative to refresh your pivot table results, actually each 
pivot table created using the same source data. 

Building a PivotTable Report – Part Three 
Grouping by dates, grouping by ranges, show items with no detail, show values in empty cells, grouping across columns 
The next illustration will focus on grouping, using both a default group as well as a self-defined group. 
Pivoting on dates, we will use a default group how to design pivot tables, we will begin with the goal report, depicted below, and then step through each design component. At the conclusion of Building a PivotTable Report, all steps will be summarized. 
This table will represent by dates, the number of employees per department and their average salary. We will also change a column header and the number font for the salary column. 
[bookmark: page_27][image: index-27_1.png]
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1
[image: index-27_2.png]

• Create the basic structure by 
dragging the start dates to the row 
labels zone and the last name to 
the values zone. 
• Select any cell with the data area 
(row labels) and right click on your 
mouse. 
• The dialog box at the right appears 
• Notice the group & ungroup 
options. 
[bookmark: page_28][image: index-28_1.png]
• The grouping dialog box appears as 
displayed to the left. 
• Excel defaulted to Months. 
• The following screen shots show 
the pivot table results for when we 
choose: 
o Months o Quarters o Years o Years & Quarters 
[image: index-28_2.png]
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[bookmark: Tables_can_also_be_grouped_by_ra]Tables can also be grouped by ranges. In our previous examples our pivot tables have broken down by department, the number of employees per department and their average salary. If we wanted to pivot our data by salary ranges we could with the end result appearing as below. 
[image: index-29_1.png]

1
[image: index-29_2.png]

• Drag the salary to the row labels 
[image: index-29_3.png]
zone and the last name to the 
values zone. 
• 2 Notice that no one makes less than 
2 $20,000 so that the range 0-19999 
does not appear. 
• To force all ranges appear, we turn 
on the option to show items with 
1 no detail. 
• To do so: 
o select any cell within the row 
labels 
o right click your mouse 
3
o Select Field Settings 
4 Select the Layout & Print tab 
o
o Check the Show items with no 
data box. 
[bookmark: 3]3


4

Let’s clean up the data a bit by removing the <0 and >0 lines, as well as having the value zero (0) 
appear for ranges with no values. 
1 • By choosing the chevron to the right of Row Labels, deselect the <0 and >120000 range. 
• To display zeros, navigate to PivotTable Tools\options tab and select Options from the 
2 PivotTable Group and select options which launches the options dialog box. 
3 • Within the Layout & Format tab, insert a zero in the box for the For Empty cells show: 
option. 
[image: index-30_1.jpg]

1
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2
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[bookmark: page_31][image: index-31_1.png]
3 

So far the only grouping we have done has been by the rows. Groups can be done by columns as well. In all of our first tables, we group on the starting date by grouping, or combining, the individual dates by month. 
Build a pivot table with the departments as the row labels and drop the start dates into the column labels. The table appears as follows: 
[image: index-31_2.png]

To group by the years, navigate your mouse to any date in the pivot table. Right click you mouse so that the dialog box appears, select group, and select years. Finish by selecting OK. The pivot table appears as below. 
[bookmark: page_32][image: index-32_1.png]
The final grouping we will review is by group by categories that are not part of the original table. Returning to the pivot table where we are pivoting be departments, counting the number of employees by department, and calculating the average salary, you will recall it appears as below. 

[bookmark: Building_a_PivotTable_Report___P_1]Building a PivotTable Report – Part Four 
User defined groups, adding/removing subtotals 
The user may define groups for data that is not included in the original source data. 
[image: index-33_1.png]

In order to group each department 
by its cabinet member, we will take 
the following steps. 
• Select those departments under 
the first cabinet member by 
CTRL +left click: 
o Alternative Ed, Inst Services, 
Special Ed 
• Choose group selection on the 
PivotTable Tools\Options tab 
and select group selection. 
• Notice that Group 1 now 
appears at the top of the pivot 
table. 
• Left click on the Group 1 header 
and type Flores. 
[image: index-33_2.png]

[bookmark: page_34][image: index-34_1.png]
Continue with the group selections until it is completed by cabinet member and appears as below. 
[image: index-34_2.png]
The departments are grouped by cabinet 
members. 
To add subtotals by cabinet members: 
• Navigate to the PivotTable 
Tools\Design Tab. 
• Select subtotals within the layout 
group. 
• Select from one of the three options: 
o Do not show subtotals o Show all subtotals at the bottom 
of the group 
o Show all subtotals at the top of 
the group. 

[bookmark: page_35][image: index-35_1.png]
Selecting the option to display 
the subtotals at the bottom of 
the group looks like this. 

Building a PivotTable Report – Part Five 
Using formulas on pivoted data 
Information displayed in a pivot table may be enhanced by adding additional computations by using formulas and functions. 
[image: index-35_2.png]

Starting with our basic average salary 
by department pivot table, we will: 
• Drag salary again down to the 
formulas zone
• Navigate to a cell with the 
column and right click the mouse 
to launch the dialog box 
• Select value fields settings to 
launch the dialog box. 

[bookmark: page_36][image: index-36_1.png]
• Navigate to the Show values as tab. 
[image: index-36_2.png]
• Instead of showing the values as normal, select the down arrow to display 
the various options. 
• In this example we want to show the values as a percent of column total. 

You may also make calculations on the pivot table results themselves. For instance, to 
calculate the percent of salaries paid by the various departments: 
• Drag the salaries once again to the formulas zone. 
• Navigate to a cell with the column and right click the mouse to launch the dialog box 
• Select value fields settings to launch the dialog box. On the summarize tab, select count. 
• Within the value fields settings dialog box now select the show vales as tab. 
• Launch the dropdown box and select Percent of grand total. 
[bookmark: The_resulting_pivot_table]The resulting pivot table 
appears to the right. 
At first glance, it may appear 
that the calculation is incorrect 
because the majority of the 
results in the % of Salary Paid by 
Department is 6.8493%. 
It is correct. The reason the 
percent is the same for so many 
departments is due to the fact 
that so many departments have 
five employees. 

Building a PivotTable Report – Part Six 
Displaying multiple row labels in columns, or tabular form. 
[image: index-37_1.png]
As with any other zone, multiple 
[image: index-37_2.png]
data fields may be added to the row 
label zone. However, depending on 
your settings, the label plus one 
indents within the table. 
To the right is an export from 
Escape of mileage paid to the IT 
staff. It is organized by Employee 
number, name, and the total of the 
amount paid each employee. 
Notice the name is displayed on a 
separate line below the EE ID and 
indented. 
So that the table is cleaner, and half 
the size, the names may be 
displayed on the same line. 
[bookmark: page_38][image: index-38_1.png]
This is a much cleaner 
presentation of the data. 
The steps performed were: 
• Display the labels in tabular 
form, and 
• eliminate the subtotals by 
employee 

To display the labels in tabular form navigate to PivotTable Tools\design tab. Within the layout group select report layout. 1
[image: index-38_2.png]

2 1
Three display options are 
available. 
[image: index-38_3.png]
By selecting show in tabular form 
the ID and the employee name will 
appear on the same row. 
[image: index-38_4.png]

Although the table is better, it still is too busy due to 
the subtotals. 
To eliminate the subtotals, we will return to the 
PivotTable Tools\design tab. This time within the 
layout group we will select subtotals, and choose the 
option not to show subtotals. 2
[bookmark: page_39][image: index-39_1.png]
The resulting report is easy to 
read. 

Other Cool Things to do with a Pivot Table – Part Seven 
Report Filters 
After dragging the site into the report filter drop zone, notice the filter that appeared on row 1 which includes the Site (label of field dragged into the filter zone) and the dropdown box in column B which will display all of the sites when the chevron is selected. 
[image: index-39_2.png]

By selecting just 1644 Magnolia as the site, only the selected information will be displayed for those individuals whose site is 1644 Magnolia. 
[bookmark: Report_Slicers]Report Slicers 
[image: index-40_1.png]
Report filters are not too exciting; slicers on the other hand are super cool. By navigating to PivotTable Tools\Sort & Filter group and select insert slicer. 
After selecting Site to filter by, a pop up appears with the list of all sites. One or many individual sites may be chosen to filter by. Holding down the shift or Ctrl keys work when selecting multiple items to filter by. 
To remove the slicer, merely select the slicer pane and press the delete key. 
[image: index-40_2.png]
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[bookmark: Expanding_Filter_Results_to_Indi]Expanding Filter Results to Individual Tabs 
Returning to the report filters, there is one feature that gives the cool slicers a run for its money. Simply put, a single criteria element results may be shown on individual pages, or worksheet tabs. 
Note the tabs below. 

Utilizing the site report filter that we have before; select PivotTable tools\Options within the PivotTable group. Then select the chevron to the left of Options and select show report filter pages. 
[image: index-41_1.png]

Only one filter can be utilized when filtering to pages. The show report filters pages pop-up will appear from which you can only select one. Once OK is selected, Excel will do some quick magic. The tabs below is after the page filter has been applied. 
[image: index-41_2.png]

Formatting as a Table - Part Eight 
[image: index-41_3.png]
It is often best to format the source data area as a table, especially if it is data that has the potential of being appended. By formatting the data as a table, as additional rows are added at the bottom of the table, without any spaces, the data area automatically expands. 
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[bookmark: page_42][image: index-42_1.png]
1
[image: index-42_2.png]

2
[image: index-42_3.png]

3
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4

Formatting Data as a Table 
1 Select a cell within your data area. From the Home tab, select format as a table from the 
styles group. 
2 Select the format I want. Choose light in this example. 
3 Excel guesses the data area. Modify if necessary. Select OK 
4 This is an example of the light table format. 

If the table format is no longer desired you may turn off the ‘table formatting’ by navigating to \table tools\ tools and select the convert to range option. 
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• Report filters is similar to a 

[image: index-43_2.png]
page break. 
• By dragging Site to Report 
Filter, the filter appears 
above the pivot table. 
• Note the site filter, in cell B1, 
displays All; and the grand 
total count is 73. 
• By selecting the chevron, a 
drop down appears, select 
1644 Magnolia. 
• The second picture displays 
only those employees at 
43 1644 Magnolia and now 
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